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Getting Started

What is Space Explorer for Windows?

Space Explorer for Windows shows the disk space used by folders and their sub-folders. 

Using Space Explorer is very easy. To use Space Explorer, first compile a list of one or more folders; 
then choose the Calculate Sizes command (using the menu or toolbar). And that’s it!    If you require 
more information while you’re using Space Explorer, press F1. This will provide context-sensitive help.

Features include:
create/save folder lists using Explorer-like window
see folder sizes in Explorer-like tree (which you can drill down, save and sort by name, size, 

allocated, wasted or date)
see folder sizes in pie, bar, line, and spline charts
view, rotate, and print 3D charts
highlight trees that exceed a certain size
multithreading support (view one group of folders while other groups are being analysed; and set 

thread priorities)
UNC support
MDI support
drag/drop support from File Manager/Explorer
install/uninstall
full context-sensitive Help.

There are many ways to use Space Explorer. For example, you can use it to find out:
which folder tree is using most space;
how much disk space is being used in users’ home folders;
if two or more folder trees are identical (by comparing their sizes); you can also browse down the 

folders to see where they differ.

See also

How the result appears

Licensing and ordering
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Licence Agreement and Copyright

Ordering Information



Licence Agreement and Copyright

Licence Agreement

You should carefully read the following terms and conditions before using this software. Your use of 
Space Explorer indicates your acceptance of this Licence Agreement.

For information on distributing the shareware evaluation version of Space Explorer, see the section titled 
Shareware Information.

Evaluation Version

This is not free software. You are licensed to use this software for evaluation purposes without charge 
for 21 days. If you use this software after the 21-day evaluation period, a registration fee is required. 

For information on how to register Space Explorer, see the section titled Ordering Information.

Registered Version

The registration fee will license one copy of Space Explorer v4.0 for Windows for use on any one 
computer at any one time. You must treat this software just like a book. For example, this software may 
be used by any number of people and may be moved from one computer location to another, so long as 
there is no possibility of it being used at one location while it is being used at another (just as a book 
cannot be read by two people at the same time).

You may access the registered version of Space Explorer through a network if you have obtained 
individual licences for the software covering all workstations that will access the software through the 
network. For example, if three workstations will access Space Explorer on the network, each 
workstation must have its own Space Explorer licence, regardless of whether the workstations are used 
to access Space Explorer at different times or concurrently.

Governing Law

This agreement shall be governed by the laws of the United Kingdom.

Disclaimer of Warranty

SPACE EXPLORER IS SUPPLIED “AS IS”. THE AUTHOR DISCLAIMS ALL WARRANTIES, 
EXPRESSED OR IMPLIED, INCLUDING, WITHOUT LIMITATION, THE WARRANTIES OF 
MERCHANTABILITY AND OF FITNESS FOR ANY PURPOSE. THE AUTHOR ASSUMES NO 
LIABILITY FOR DAMAGES, DIRECT OR CONSEQUENTIAL, THAT MAY RESULT FROM THE USE OF 
SPACE EXPLORER. 

THE USER MUST ASSUME THE ENTIRE RISK OF USING SPACE EXPLORER.

Copyright

Space Explorer for Windows, copyright © 1994-1997 Praful Kapadia. All rights reserved.



Ordering Information

Why register?

This is not free software. You are licensed to use this software for evaluation purposes without charge 
for 21 days. If you find this software useful and continue using it after the 21-day evaluation period, a 
registration fee is required. Unregistered use of Space Explorer after the 21-day evaluation period is in 
violation of UK and international copyright laws.

By registering, you will:
receive a registration number (via e-mail if you provide an e-mail address);
not see the reminder screen when you start Space Explorer;
receive free technical support via e-mail for 6 months;
see your name and registration number displayed in the About box;
help support the shareware concept; by registering shareware, you will encourage shareware 

authors to develop their existing programs and to develop new programs. If you find shareware useful but 
do not register it, you may find that eventually there will be no shareware for you to try out. Do not 
assume that other people will register so you don’t have to!

How to register

You can pay using one of the following methods:
by cheque (check) using the order form; or
by using the shareware registration service on CompuServe.

Site licence arrangements may be made by contacting the author. 

All orders are subject to the Space Explorer Licence Agreement.

See also

How to let Space Explorer know you  ’  ve registered  



Order Form

A payment of £15 (15GBP) must be made in GB pounds drawn on a GB bank. You can also send 
international postal money orders in GB pounds.

Cheques or money orders should be made payable to:

“P Kapadia”

Payment should be sent to:

P Kapadia
75 Salisbury Walk
London N19 5DU
United Kingdom 

To print the form, choose the Print Topic command on the File menu. 

___________________________________________________________________________

Name: _______________________________  Date: ___________________

Company: _______________________________________________________

Address: _______________________________________________________

         _______________________________________________________

City, State: ___________________________________________________

Zip/Postcode: __________________________________________________

Country: _______________________________________________________

Day Phone: ________________________  Eve: ______________________

Electronic Mail address: _______________________________________

How did you hear about Space Explorer?

Comments:



Registering using CompuServe

You can register Space Explorer by using the shareware registration service on CompuServe. A 
registration fee of $25 (25USD) will be automatically added to your CompuServe bill. 

To register, use the CompuServe command GO SWREG, select “Register Shareware” and follow the 
menus. The registration number for Space Explorer is 14576. The rest of this section provides detailed 
instructions for registering Space Explorer.

Registering using WinCIM:

1. From the Services menu, choose the Go command and type SWREG.

2. In the Shareware Registration box, double click on the “Register Shareware” line. The Registration 
Agreement dialogue box appears.

3. After you have read the Registration Agreement, click on Proceed. The Geographic Region dialogue 
box appears.

4. Select your region.

5. In the Register Shareware box, double click on Registration ID and enter 14576 as the ID number:

6. Double click on “Display Selected Titles”.

7. Click the Register button to fill in your order information. 



Shareware Information

The full licence agreement is provided in the section titled Licence Agreement and Copyright. Please 
read it before using this software.

Evaluation and Registration

This is not free software. You are licensed to use this software for evaluation purposes without charge 
for 21 days. If you use this software after the 21-day evaluation period, a registration fee is required. 

Please see the section titled Ordering Information to find out how you can register Space Explorer.

Distribution

Provided that you distribute only the shareware version (that is, you do not pass on any registration 
details), you are licensed to:

make as many copies of the shareware version of this software and documentation as you wish;
give exact copies of the original shareware version to anyone;
distribute the shareware version of the software and documentation in its unmodified form via 

electronic means. 

There is no charge for the above.

You are prohibited from:
charging, or requesting donations, for any such copies, however made; 
distributing the software and/or documentation with other products (commercial or otherwise) 

without prior written permission.



Register Space Explorer

Once you receive a registration number, you can let Space Explorer know you have registered:

1. From the Help menu, choose the Register command.

2. Enter your name and registration number exactly as they appear on the registration instructions 
sent to you when you registered Space Explorer. You cannot substitute a different spelling for your 
name or use a different name. If you register correctly, your name will appear in the About dialogue 
box, and the registration reminder dialogue box will no longer be displayed when you start Space 
Explorer. 

You should save the registration instructions for possible use with future upgrades, or in case you re-
install Space Explorer.

Note      If your name is spelt incorrectly in the registration instructions, please contact the author to 
receive a new registration number.



Menu Commands

Choose one of the following to get help on its sub-menus:

File menu commands

View menu commands

Chart menu commands

Folder menu commands

Tools menu commands

Windows menu commands

Help menu commands

You can get help on any menu command while you are using Space Explorer. To get help, highlight the 
menu command and press F1.

Many menu commands can be accessed more quickly by keyboard shortcuts.



File Menu Commands

The following commands are available on the File menu:

New

Open

Save Folder Selection

Save Folder Selection As

Save Result Tree As

Save Result List As

Open Chart Template

Save Chart Template

Print Chart

Properties

Stop

Close

Exit

Note      The menu commands that appear on the File menu vary according to the window that is 
highlighted. For example, the Close command appears only when you select a result window.



New Command (File Menu)

The New command clears all folder selection details so that you can create a new list.



Open Command (File Menu)

The Open command opens a file that contains folder selection information. Use the Save Selection 
command to save folder selection information.

You can also open a file by dragging it from File Manager (or Explorer) onto Space Explorer.



Save Folder Selection Command (File Menu)

The Save Folder Selection command saves folder selection information in a text file.



Save Folder Selection As Command (File Menu)

The Save Folder Selection As command saves the folder selection in a text file. You are asked for a new 
file name.



Save Result Tree As Command (File Menu)

The Save Result Tree As command saves the folder tree of a result window in a text file.



Save Result List As Command (File Menu)

The Save Result List As command saves the folder list of a result window in a text file.



Open Chart Template Command (File Menu)

The Open Chart Template command opens a chart settings file. The settings from the file are applied to 
the current result window. You can save chart settings by using the Save Chart Template command.



Save Chart Template Command (File Menu)

The Save Chart Template command saves chart settings of a result window. The settings saved include 
the chart type, colours and fonts. You can apply the settings to new charts by using the Open Chart 
Template command. Some settings (such as the width of the legend bar) are not saved. This is a 
peculiarity of the software used to generate the charts!

Templates have many uses, for example, you can create different templates for printing charts on black 
and white, and colour printers.



Close Command (File Menu)

The Close command closes a result window.



Print Chart Command (File Menu)

The Print Chart command prints the chart displayed in the result window.

You may want to change various settings before you print a chart, for example, title and legend fonts.



Properties Command (File Menu)

The Properties command displays the properties for the result window. The properties displayed are:
Total size: the size of all folders in the Folder Selection list
Files: the total number of files in all folders in the Folder Selection list
Folders: the total number of folders in all folders in the Folder Selection list
Filter: the file filter used to calculate the results (for example *.txt)
Time taken: the elapsed time between starting the calculation and it ending



Stop Command (File Menu)

The Stop command terminates the calculation that is occurring in the highlighted the result window.

If you choose the Stop command, the results displayed may not be correct. 



Exit Command (File Menu)

The Exit command closes Space Explorer.



View Menu Commands

The following commands are available on the View menu:

Toolbar

Status Bar

Result Bar

Colour Bar

Pattern Bar

Legend

Large Icons

Small Icons

List

Details

Pie Chart

Bar Chart (Column)

Bar Chart (Horizontal)

Area Chart

Line Chart

Spline Chart

Arrange Icons

The default settings for the different type of views can be specified using the View options

Note      Some of these menu commands appear only when you select a result window.



Toolbar Bar Command (View Menu)

The Toolbar command shows or hides the toolbar. A tick appears next to the command when the toolbar 
is visible.



Status Bar Command (View Menu)

The Status Bar command shows or hides the result bar. A tick appears next to the command when the 
status bar is visible.



Result Bar Command (View Menu)

The Result Bar command shows or hides the result bar. A tick appears next to the command when the 
result bar is visible.



Colour Bar Command (View Menu)

The Colour Bar command shows or hides the colour bar. A tick appears next to the command when the 
colour bar is visible. The colour bar is a palette of colours that you can use to change chart colours.

If you want to change the colours used by charts, drag a colour from the colour bar to the area of the 
chart that you want to change. 

Space Explorer does not remember colour changes. Therefore any colour changes you make are lost 
once you close the result window. You can, however, save chart properties in a template and re-apply 
them to new charts.

See also

Open Chart Template

Save Chart Template



Pattern Bar Command (View Menu)

The Pattern Bar command shows or hides the pattern bar. A tick appears next to the command when 
the pattern bar is visible. The pattern bar displays various patterns that you can use to apply patterns to 
charts.

If you want to change the patterns used by charts, drag a pattern from the pattern bar to the area of the 
chart that you want to change.

Space Explorer does not remember pattern changes. Therefore any pattern changes you make are lost 
once you close the result window. You can, however, save chart properties in a template and re-apply 
them to new charts.

See also

Open Chart Template

Save Chart Template



Legend Command (View Menu)

The Legend command shows or hides the legend to the right of a chart. A tick appears next to the 
command when the legend is visible. The legend is key that shows the colours used to represent folders 
and files.



Large Icons Command (View Menu)

The Large Icons command displays folders and files by using large icons.



Small Icons Command (View Menu)

The Small Icons command displays folders and files by using small icons.



List Command (View Menu)

The List command displays folders and files in a list.



Details Command (View Menu)

The Details command displays the name, size and date of folders and files.

You can click on the columns to sort the items in ascending or descending order. Click once to sort the 
items in ascending order, click twice to sort them in descending order.

The sizes displayed for folders is the size of the folder tree, that is the size of all sub-folders of the folder 
and all their sub-folders (and so on)



Pie Chart Command (View Menu)

The Pie Chart command displays a pie chart for the selected folder. Choosing this command will 
override settings you have made in the Chart Options dialogue box.

See also

Open Chart Template

Save Chart Template



Bar Chart (Column) Command (View Menu)

The Bar Chart (Column) command displays a vertical bar chart for the selected folder. Choosing this 
command will override settings you have made in the Chart Options dialogue box.

The order of the bars on the chart is determined by the list order of the files and folders. If you have not 
displayed the folder in a list, the order of the tree view is used. 

See also

Open Chart Template

Save Chart Template



Bar Chart (Horizontal) Command (View Menu)

The Bar Chart (Horizontal) command displays a horizontal bar chart for the selected folder. Choosing 
this command will override settings you have made in the Chart Options dialogue box.

The order of the bars on the chart is determined by the list order of the files and folders. If you have not 
displayed the folder in a list, the order of the tree view is used. 

See also

Open Chart Template

Save Chart Template



Area Chart Command (View Menu)

The Area Chart command displays an area chart for the selected folder. Choosing this command will 
override settings you have made in the Chart Options dialogue box

The order of the areas on the chart is determined by the list order of the files and folders. If you have not 
displayed the folder in a list, the order of the tree view is used. 

See also

Open Chart Template

Save Chart Template



Line Chart Command (View Menu)

The Line Chart command displays a line chart for the selected folder. Choosing this command will 
override settings you have made in the Chart Options dialogue box

The order of the points on the chart is determined by the list order of the files and folders. If you have 
not displayed the folder in a list, the order of the tree view is used. 

See also

Open Chart Template

Save Chart Template



Spline Chart Command (View Menu)

The Spline Chart command displays a spline chart for the selected folder. Choosing this command will 
override settings you have made in the Chart Options dialogue box

The order of the points on the chart is determined by the list order of the files and folders. If you have 
not displayed the folder in a list, the order of the tree view is used. 

See also

Open Chart Template

Save Chart Template



Arrange Icons Commands (View Menu)

The Arrange Icons commands sort folders and files in ascending or descending order. The items can be 
sorted by name, size, allocated disk space, wasted (unused) disk space, and modified date.

See also

Result list



Chart Menu Commands

The following commands are available on the Chart menu:

Copy Chart to Clipboard

Copy Data to Clipboard

3D

3D View

Rotate 3D View

Titles

Fonts

Options

Note      These menu commands appear only when you select a result window.



Copy Chart to Clipboard Command (Chart Menu)

The Copy Chart to Clipboard command copies the displayed chart to the Windows clipboard. Use the 
Paste command to insert the chart into other programs.



Copy Data to Clipboard Command (Chart Menu)

The Copy Data to Clipboard command copies the data for the displayed chart to the Windows clipboard. 
Use the Paste command to insert the chart into other programs.



3D Command (Chart Menu)

The 3D command switches between 2D and 3D charts. 

To see charts in perspective, use the 3D View command.



3D View Command (Chart Menu)

The 3D View command enables or disables 3D View. When you enable 3D View, a chart is switched to 
3D first. With 3D View, you can see charts in perspective (except for pie charts). Use the Rotate 3D 
View command to change the X and Y angles of the 3D chart.



Rotate 3D View Command (Chart Menu)

The Rotate 3D View rotates a chart displayed in 3D View (perspective). If the chart is not displayed in 
3D View, this command has no effect. 

This command has no effect on pie charts.



Titles Command (Chart Menu)

The Titles command shows or hides chart titles. Chart titles can appear on top of charts or on either of 
the number axes. 

Pie charts do not have a number axis; other charts have a number axis either to the left of or below the 
chart.



Fonts Command (Chart Menu)

The Fonts command changes fonts for legends and titles. 

Font settings are not saved when you exit Space Explorer. You can, however, save chart properties 
(such as fonts) in a template and re-apply them to new charts.

See also

Open Chart Template

Save Chart Template



Options Command (Chart Menu)

The Options command displays the Chart Options dialogue box which lets you change various chart 
settings. Most the settings you change in the chart options are not saved when you exit Space Explorer. 
Similarly, if you change the chart view (for example by choosing the pie chart view), some of the settings 
you changed in the Options dialogue box are lost. This is because the various chart views have preset 
values.



Folder Menu Commands

The following commands are available on the Folder menu:

Calculate Sizes

Add to Selection

Remove from Selection



Calculate Sizes Command (Folder Menu)

The Calculate Sizes command starts the calculation process. This involves working out the sizes of your 
selected folders (and their sub-folders).

The output appears in the result window.



Add to Selection Command (Folder Menu)

The Add Selection command copies a folder name from the Available Folders list to the Selected 
Folders list.

You can also add a folder name to the Selected Folders list by dragging it from the Available Folders list, 
or from File Manager (or Explorer). If you use File Manager or Explorer, you can drag more than one 
folder onto Space Explorer.

See also

Remove from Selection



Remove from Selection Command (Folder Menu)

The Remove from Selection command removes a folder name from the Selected Folders list.

See also

Add to Selection



Tools Menu Commands

The following commands are available on the Tools menu:

Options

Map Network     Drive  

Disconnect Network Drive



Options Command (Tools Menu)

The Options command displays the Options dialogue box which lets you change options for Space 
Explorer.



Map Network Drive Command (Tools Menu)

The Map Network Drive command maps a letter to a network drive.

This command is available only if a network is detected.

See also

Disconnect Network Drive



Disconnect Network Drive Command (Tools Menu)

The Disconnect Network Drive command removes a mapping between a letter and a network drive.

This command is available only if a network is detected.

See also

Map Network     Drive  



Window Menu Commands

The following commands are available on the Window menu:

Tile

Cascade

Arrange Icons

Reset Folder Selection Window

Refresh



Tile Command (Window Menu)

The Tile command arranges all windows so that they do not overlap on the screen. Use this view to see 
windows that may be hidden or to organise the windows on the screen.



Cascade Command (Window Menu)

The Cascade command arranges all windows so that they overlap on the screen. Use this view to see 
windows that may be hidden or to organise the windows on the screen.



Arrange Icons Command (Window Menu)

The Arrange Icons command arranges all iconised windows on the screen.



Reset Folder Selection Window Command (Window Menu)

The Reset Folder Selection Window command resizes the Folder Selection window and places it above 
all other Space Explorer windows.



Refresh Command (Window Menu)

The Refresh command updates the screen display. You can use this command to update the list of drive 
letters if you, for example, map new drives from File Manager or Explorer. If you map drive letters from 
Space Explorer, the Refresh command is automatically carried out.



Help Menu Commands

The following commands are available on the Help menu:

Contents

Ordering Information

Register

About



Contents Command (Help Menu)

The Contents command displays this Help file.



Ordering Information Command (Help Menu)

The Ordering Information command displays instructions for ordering Space Explorer.



Register Command (Help Menu)

The Register command registers Space Explorer.



About Command (Help Menu)

The About command displays program information about Space Explorer.



Folder Level to Display

Setting the folder level affects how far down a folder tree you can see in the result window and what 
information is saved when you save the contents of the result window. The sizes displayed in the result 
window are unaffected. For example, if a folder structure consists of:

C:\APPS

\WORD

TEMPLATE

\EXCEL

and you specify a level of 2, you will be able to view the folder sizes for APPS, WORD and EXCEL but 
not TEMPLATE. 

This option is useful if you have a server whose structure is something like:

\USERS

\FRED

\JANE

\MARIE

By specifying a level of 2, you can find out how much disk space is used by each person. No information 
about the users’ sub-folders will be provided and, when you save the results, information about the 
users’ sub-folders will not be saved.



Keyboard Shortcuts

If you prefer to keep your hands on the keyboard when you are working, you can use the shortcut keys. 
For example, pressing CTRL+C lets you calculate the sizes of selected folders; it is the same as 
choosing Calculate Sizes from the Folder menu.

The following table provides available shortcut keys.

To Press

New (folder selection) CTRL+N

Open (folder selection) CTRL+O

Save (folder selection) CTRL+S

Stop calculation CTRL+Z

Exit CTRL+X

Calculate sizes CTRL+L

Add to folder selection CTRL+A or
INSERT

Remove from folder selection CTRL+R or
DELETE

Options CTRL+T

Refresh Folder Selection display F5

Reset Folder Selection Window CTRL+W

Note      The ‘+’ means you should press and hold down the keys mentioned at the same time. For 
example, CTRL+S means you should press and hold down the CTRL key, and then press the S key 
(without releasing the CTRL key); you should then release both keys at the same time.



Main Window

The main window of Space Explorer contains the following elements:

Path

Filter

Folders to choose from

Drives available

Files in folder

Add button

Selected Folders

Description

Clear List button

Remove button



Path (Main Window)

The Path box lets you manually change the current drive letter and folder for which details are 
displayed.

The Path box accepts UNC (Universal Naming Convention) paths. The format of UNC paths is \
\SERVER\SHARENAME.



Filter (Main Window)

The filter box determines which files are used to calculate the sizes of folders. For example, if you want 
to know how much disk space is being used by files with extension TMP, select the *.TMP filter.

The list of filters cannot be amended.



Folders to Choose From (Main Window)

The folder box displays folders for the drive currently selected. 

You can add files to the Selected Folders list by:
pressing the Add button; or
dragging a folder to the list; or
pressing the Insert key. 



Drives Available (Main Window)

The drive box displays drives currently available. Press F5 to update the list.



Files in Folder (Main Window)

The file box displays files in the folder currently selected.

You can double-click on a filename to open the file.



Add button (Main Window)

The Add button copies a folder name from the folder list to the Selected Folders list.

See also

Folders to choose from



Selected Folders (Main Window)

The Selected Folders list displays paths for which folder sizes are calculated.



Description (Main Window)

The Description box lets you provide a name for the list you create. This description is saved when you 
save the Selected Folders list. For example, if the folder selection contains users’ home folders on 
server ACCOUNTS, you can type ‘Users on ACCOUNTS server’.



Clear List button (Main Window)

The Clear List button removes all entries in the Selected Folders list.



Remove button (Main Window)

The Remove button removes the currently highlighted entry in the Selected Folders list.



Options Dialogue Box

The Options dialogue box is displayed when you choose the Options command from the Tools menu. 

You can change the following options:

Results options

Display options

View options

Advanced options



Options: Results

The Results options are part of the Options dialogue box. The Results options affect the display of the 
result window. 

Note      The Results options take effect for new folder calculations only. Any completed or active 
calculations use the Results options that were set when the folder calculations started.

You can change the following Results options:

Unit

Determines what unit is used to display the results. Folder sizes in the result window can be expressed 
in bytes, kilobytes (KB) or megabytes (MB).

One kilobyte is 1,024 bytes and one megabyte is 1,048,576 bytes

Formatting

The following options determine how the folder sizes are formatted.

Show thousand separator

Displays a separator between groups of digits in large numbers, for example: 1,000,000.

Append unit name

Displays the unit used for the folder size. The unit is bytes, K (for kilobytes), or MB (for megabytes).

Highlight

The following option highlights certain folders.

Folder trees exceeding ...

Highlights a folder if its size and the size of its sub-folders exceed the value specified. The unit used to 
express the value is the same as the unit specified in the Unit box.

Folder levels to display

The following option determines the structure of the result window.

Maximum folder levels to display

Displays all or some folder levels. This affects how far down a folder tree you can see and what 
information is saved when you save the contents of the result window. The sizes displayed in the result 
window are unaffected. For example, if a folder structure consists of:

C:\APPS

\WORD

TEMPLATE

\EXCEL

and you specify a level of 2, you will be able to view the folder sizes for APPS, WORD and EXCEL but 
not TEMPLATE. 

This option is useful if you have a server whose structure is something like:



\USERS

\FRED

\JANE

\MARIE

By specifying a level of 2, you can find out how much disk space is used by each person. No information 
about the users’ sub-folders will be provided and, when you save the results, information about the 
users’ sub-folders will not be saved.



Options: Display

The Display options are part of the Options dialogue box. You can change the following Display options:

Tool tips

Tool tips are small windows that pop-up to provide immediate help about parts of the screen.

Toolbar

Displays tips when you position the mouse over a button on the toolbar.

Window position at startup

The following options determine where on the screen Space Explorer appears when you start it.

Centre of screen

Displays main window in the centre of the screen.

Last saved

Displays main window in the position it was when you last quit Space Explorer.

Number of recently used entries for

These options specify how many past entries are saved in the file and path lists.

Files

Specifies how many recently opened and saved files appear in the File menu.

Paths

Specifies how many paths you typed appear in the Path list.



Options: View

The View options are part of the Options dialogue box. These options affect the display of the result 
window. Most of the these options are used to determine how charts are displayed when they are first 
created. You can change the following View options:

View

These options determine whether files and folders are displayed for a new result window or a chart with 
a certain colour scheme.

Type

Specifies which item view is displayed or which chart.

Sort order

Specifies how items are sorted in the list of files and folders.

Colour scheme

Specifies which colour scheme is used for charts.

Bars

These options show or hide tool bars.

Result bar

Determines whether the result bar is shown or hidden.

Pattern bar

Determines whether the pattern bar is shown or hidden.

Legend

Determines whether the chart legend is shown or hidden.

Titles

These options show or hide titles.

Top title

Determines whether a title is shown above the chart.

Axis title

Determines whether a title is shown for the number axis.

Dimensions

These options determine the dimensions of a chart (2D, 3D, perspective).

3D

Determines whether chart is shown in 3D.

3D View

Determines whether chart is shown in 3D with perspective. The 3D option (above) must be enabled to 
view charts with perspective.



Options: Advanced

The Advanced options are part of the Options dialogue box. Do not change these options unless you 
are an experienced user of Windows and are familiar with the concepts mentioned below:

Calculation thread priority

The calculation thread priority determines which Windows thread priority a calculation is started with. 
Each calculation runs in its own thread. The main thread priority is always Normal. 

Changing the thread priority to the highest value is not necessarily the optimum setting. The optimum 
setting depends on a number of factors. The default setting usually provides good performance.

Thread Priority Meaning

Highest The thread’s priority is two points above normal. 

High The thread’s priority is one point above normal.

Normal The thread has normal priority.

Below normal The thread’s priority is one point below normal.(recommended)

Low The thread’s priority is two points below normal.

Lowest The thread executes only when the system is idle. Windows won’t 
interrupt other threads to execute a thread with this priority.

Note      All updates to the result windows are performed by the main process thread (which always runs 
at Normal priority). This occurs because each calculation thread passes updates to the main thread. 
Therefore, setting the calculation thread priority equal to or greater than Normal will usually create a 
bottleneck and, consequently, reduce the responsiveness of Space Explorer. 

On computers with multiple processors, the multithreading behaviour will be different. To find the best 
setting, try experimenting!

Windows Explorer

Add shell extension

Adds Space Explorer to the Windows Explorer context menus. 

Enabling this option lets you start a calculation by clicking the secondary button of your mouse on a 
folder in Windows Explorer and choosing Space Explorer from the context menu.

You can also start Space Explorer from the command prompt.



Result Window

The result window displays information in three ways:
as a tree.
as a list.
as a chart.



Result Tree

The result tree looks like this:

The picture shows that the number in brackets (after the name of a folder) always indicates the nominal 
size of a folder and all its sub-folders (not the allocated size). A breakdown of the size is provided by the 
list view and the chart view.



Result List

If you select the Small Icons, Large Icons, List, or Details view, files and folders are displayed:

The size of a folder provides the size of folder and all its sub-folders. It provides the same information as 
that which appears in brackets in the tree view except it is always expressed in kilobytes (KB).

The meaning of the columns in the list is provided in the following table:

Column Meaning

Name The name of the file or folder.

Size The nominal size of files in the folder tree or a file. 
This is the minimum space required by the folder 
tree or file.

Allocated The actual disk space allocated for files in the folder 
tree or a file. This figure is usually larger than Size 
because filing systems (such as FAT and NTFS) 
use clusters when allocating space for files. A 
cluster is the minimum space allocated to a file 
when it requires more space. It is usually a multiple 
of 4K. For example, if the cluster size is 4K and a 
file requires 5K, the file will still use up 8K of disk 
space (because it will be allocated two clusters of 
4K).

Wasted This is the difference between the Size and 
Allocated values. It indicates the amount of 
allocated space that is unused.

Modified Date and time the folder or file was last modified.



Note      If you have chosen a UNC path instead of a drive letter the Allocated and Wasted columns may 
display incorrect information. This is because Space Explorer cannot find out the cluster size of a UNC 
path.

You can:
open a file by double-clicking on it;
view the contents of a folder by double-clicking on it;
sort any column in ascending or descending order by clicking on the column; two consecutive 

clicks on a column reverses the sort order, for example,    if you click once on the Size column, the folders 
and files are sorted in ascending order; if you click again, they are sorted in descending order.

See also

Chart view



Result Chart

The chart view provide a breakdown of the folder selected in the tree view. The following is an example 
of a chart:

You can click on and drag various parts of a chart. See the above diagram or try experimenting!

A chart consists of values for files and folders. The Files section of a chart indicates the space used by 
files in the folder selected. The other folders indicate the tree sizes of the sub-folders of the selected 
folder. For example, if the number in brackets in the tree view of a folder is 100KB then a pie chart could 
have 20KB for one sub-folder’s tree size, 70KB for another sub-folder’s tree size and 30KB for the size 
of all files in the selected folder.

See also

List view



Excluded Folders

Windows NT and Windows 95 do not allow folder paths to exceed about 260 characters. Therefore, 
some of the sizes shown in the result window may be incorrect if long paths are found. You will be told if 
long paths are found.

Long paths may exist for many reasons, for example:
the folders were created using another operating system;
a sub-folder is shared out and many sub-folders are added by the user connected to the share; 

consequently, the new path relative to the share may be valid but invalid relative to the sub-folder’s 
absolute path on the server.

See also

The folder sizes are not correct



Procedures

How to use Space Explorer

How to let Space Explorer know you  ’  ve registered  



How to use Space Explorer

The basic procedure for using Space Explorer is to compile a list of one or more folders and then to 
choose the Calculate Sizes command (using the menu or toolbar).The following provides a step-by-step 
guide:

1. In the Available Folders box, locate the folder whose tree size you want to find out.

2. Choose the Add Button to add the folder to the Selected Folders list.

3. Repeat steps 1 and 2 for other folders whose tree sizes you require.

4. To start the calculation, press the Calculate Sizes button on the toolbar.

The result window will display the folder sizes.

Examples of using Space Explorer

1. If you want to find out how much space is used by all files on your C: drive, add the C: drive to the 
Selected Folders list.

2. If you want to find out the total space used by users in their home folders, add each user’s home 
folder to the Selected Folders list. Alternatively, if the home folders are the sub-folders of a particular 
folder, add the parent folder of the home folders to the Selected Folders list.

See also

Results options

The folder sizes are not correct



Questions, Problems and Solutions

The folder sizes are not correct

The settings for the 16-bit and 32-bit versions are not synchronised

Some chart options are not saved



The folder sizes are not correct

The sizes returned for folders may be wrong or appear to be wrong for several reasons. Here are some:
If you are comparing the sizes returned by Space Explorer with another program, it is possible 

that the other program does not include certain files and folders; for example, system and hidden files 
may be excluded. Space Explorer includes system and hidden files. Also, if you are running Windows 95 
or Windows NT version 4, some programs may exclude system folders such as the RECYCLED folder. 
The DIR command excludes the RECYCLED folder by default.

The sizes returned by Space Explorer may be incorrect if the folder path is being updated while 
Space Explorer is running.

The sizes returned by Space Explorer may be incorrect if it finds long paths. See the section titled 
Excluded Folders for more information.

The sizes returned by Space Explorer may be incorrect if you do not have “list” permission for the 
complete folder tree. This usually means your network administrator does not want you to see the 
contents of specific folders. The consequence is that the folders cannot be seen by Space Explorer.

The sizes returned by Space Explorer may be incorrect if you stop a scan before it finishes.
If you have chosen a UNC path instead of a drive letter the Allocated and Wasted columns may 

display incorrect information. This is because Space Explorer cannot find out the cluster size of a UNC 
path.

Important      During testing, the results produced by Space Explorer were double checked and found to 
be accurate. If it is important to you that the results produced by Space Explorer are entirely correct, you 
are advised to double check them.



The settings for the 16-bit and 32-bit versions are not synchronised

The preferences you specify in the Options dialogue box and the position of the two main Windows are 
saved in different places for the 16-bit and of Space Explorer. Therefore, any changes you make in the 
16-bit version are not reflected in the 32-bit version (and vice-versa). 

For the 16-bit version, your preferences are saved in the file PKDIRUSE.INI.

For the 32-bit version, your preferences are saved in the Windows Registry.

Warning      Do not modify PKDIRUSE.INI or the Windows Registry. Incorrect modifications may cause problems for 
Space Explorer or your computer.



Some chart options are not saved

In this version of Space Explorer some chart options are not saved automatically. Examples of options 
not saved include point types, fonts, colours and patterns. Some options set in the Chart Options 
dialogue box are overridden by choosing one of the pre-defined chart types (such as pie chart). If you 
want to save chart options (such as fonts and colours) so that they can be re-applied later to another 
chart, use the Open Chart Template and the Save Chart Template commands.

There are many chart options that can be preset in the Tools Options dialogue box. You can assume 
that any chart option that does not appear in this dialogue box is not saved when you close a result 
window.



Setup and/or startup problems

If Space Explorer fails to install, check that your computer satisfies the system requirements. In 
particular, you will require support for ActiveX. If you run Internet Explorer or any other program that 
uses OLE, you will probably have the required OLE files installed on your computer.

Space Explorer has not been tested on Windows NT 3.51. It is possible that Space Explorer may run on 
Windows NT 3.51 with Service Pack 5.



Feedback

Before sending any comments, check this Help file, especially the section titled Questions, Problems 
and Solutions.

You can send suggestions, problems and questions using:

Electronic mail (Internet): Praful@CompuServe.com

Post: Praful Kapadia, 75 Salisbury Walk, London, United Kingdom, N19 5DU. 

Web site: http://ourworld.compuserve.com/homepages/praful

The web site contains updates and shareware/freeware software.

If you are sending bug reports, please provide as much information as possible, such as:
operating system;
version numbers;
error message(s);
steps to reproduce error;
how you can be contacted, for example, your e-mail address.
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Technical Information

This section provides background information about Space Explorer. You do not need to know it to use 
Space Explorer.

Version history

System requirements

Production information

Limitations



Version History

This section provides the history of Space Explorer.

Version 1.0 (1994)

This version was written in Microsoft Visual Basic. It provided folder sizes for a list of user-specified 
folders.

Version 2.0 (August 1995)

This version was functionally identical to version 1. The folder sizing routines were replaced by a DLL 
written in Borland Delphi. This reduced the time taken to sum up sizes for large folder trees from 
minutes to seconds.

Version 3.0 (January 1997)

This was a complete re-write in Borland Delphi 1.0. The following features were added:
The results were displayed using the File Manager/Explorer tree metaphor. This meant only top 

level folders needed to be specified because other information could be obtained by drilling down to lower 
folders.

User-configurable units for results.
User-configurable formatting.
Maximum folders to display
Context-sensitive help.

Version 4.0 (March 1997)

This was the first 32-bit version for Windows 95 and Windows NT. The following features were added:
Use of Windows 95 and Windows NT 4 controls.
Multithreading support
Multiple chart views: pie, bar, line, and spline
Multiple list views (a la Explorer)
Options for multithreading and charts
Name changed from PKDirUse for Windows to Space Explorer for Windows



System requirements

The table below describes the system requirements for Space Explorer. You may find that you do not 
need a computer with a specification that matches these requirements. If your computer’s specification 
falls significantly below these requirements, you may find that the 16-bit version of Space Explorer 
(called PKDirUse v3.0 for Windows) provides better performance.

Component Requirement or Recommendation

Operating system Windows NT 4 (or higher)
Windows 95 (or higher)

Processor 486 100Mz or faster (Windows 95)
Pentium 90mhz or faster (Windows NT)

Memory 16MB or greater (Windows 95)
32MB or greater (Windows NT)

Disk space 1MB

Software ActiveX (OLE) support

You may require a higher specification computer if you start many threads simultaneously in Space 
Explorer.



Production Information

The following were used to produce Space Explorer:
Software development: Borland Delphi version 2.0.
Help file: Microsoft Word 6.0 using a template based on the WHAT6 template.
Graphics: CorelDraw 3.0 and Paint for splash screen and Paint for Help file graphics and program 

bitmaps.



Limitations

The Space Explorer has the following known limitations:
The maximum size of a folder tree is 1.7 * 1038 bytes (10 to the power of 38).
The maximum length of a folder path is determined by Windows NT or Windows 95 (see the 

section titled Excluded Folders for more information).
There is no (known) built-in limit to the number of threads that can be run simultaneously. Usually, 

the computer’s specification will determine the maximum number of threads that can be run. 



Mission Statement: for Space Explorers everywhere

Disk space, the final frontier,
these are the voyages of the Space Explorer,

its ongoing mission,
to explore strange new machines

to seek out new files and new configurations,
to boldly go where many have gone before.

[With apologies to GR] 



Drag

To drag an object (such as a file or colour): 

1. click on the object with your mouse button;

2. hold down the mouse while you drag the object to its destination;

3. release the mouse button.



Command Line Parameters

Space Explorer can be called from Windows Explorer and the Windows command prompt. The 
command line syntax is:

pkduse32 [ Folder Name | Folder Selection File ]

where 

Folder Name is the name of a folder whose tree size you want to calculate when Space Explorer 
starts; and

Folder Selection File is the name of a folder selection file whose folders’ tree sizes you want to 
calculate when Space Explorer starts.

Examples

Command line Meaning

pkduse32 Start Space Explorer

pkduse32 C:\Windows Start Space Explorer and calculate the 
tree size of the C:\Windows folder

pkduse32 Select1.txt Start Space Explorer and calculate the 
tree sizes of all the folders in the 
Select1.txt file




